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PTV Vistro 2022 —What’s New

Adam Lynch
Senior Product Manager for Traffic Engineering (Global)
Technical Product Manager for PTV Vistro
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Excellent customer presentation

* Quantifiable and Relatable Results
* Compatibility
* Flexibility

* Multiple Scenarios in One File

Social Activities
Benefits of « Easy Updating

CO m m U n ity aCtiViti es: PTV Vlst ro * Trip Generation Built into Model

* Internal Program QC

* Trip Distribution via Zones,
Gates, and Paths

* Scenario Testing

Positive feedback on past improvements
Validates that we are heading in the right direction.

Customers presenting Vistro at conferences

Very nice to see! Thanks! Keep it up!

ITE Campaigns / PTV Talks Market Standard ->Canada
PTV Vistro LinkedIn forum - el GUEE OC

. . . CANADIAN CAPACITY GUIDE
We would like to see more users sharing experiences.

New Major Customers
W Valley
v y ) Transportation
@ " Authority
Montréal &3

PTV activities
Institute of Transportation Engineers Journal
PTV Talks - Vistro Edition
PTV Blog - Silicon Valley VTA Story
LinkedIn and information sharing

y CITY OFHOUSTON

PTV Vistro investigates Lead
Pedestrian Intervals for your city.


https://youtu.be/HQ3CDdR1UNc?t=953
https://youtu.be/HQ3CDdR1UNc?t=953

PTV Vistro is in an Urban Mobility System D
Copy link

Increasing Knowledge-base

There is great feedback from long-time users and new
customers about the videos and articles we've prepared.

Features and Use Cases

Web and Video Training

Self-Learning

Urban Mobility System

PTV ] VISTRO

Pearl St. Mall’s
Interactive Demo
Boulder, CO

Excellent resources to share with new users.

Learn more about PTV Vistsghe

MORE VIDEOS : roup. cor

P o) 004/525 B & Youlube 3

Interactive Demo Made for PTV Talks



https://www.ptvgroup.com/en/solutions/products/ptv-vistro/knowledge-base/feature-learning-center/
https://www.ptvgroup.com/en/solutions/products/ptv-vistro/knowledge-base/training-web-series/
https://www.ptvgroup.com/en/solutions/products/ptv-vistro/knowledge-base/ptv-vistro-self-learning-and-training/
https://www.ptvgroup.com/en/best-traffic-signal-optimization-software/
https://www.ptvgroup.com/en/best-traffic-signal-optimization-software/
https://youtu.be/MXWgrOIeNsU
https://youtu.be/MXWgrOIeNsU
https://www.ptvgroup.com/en/best-traffic-signal-optimization-software/

PTV Vistro 2022 - Release

HCM 7 (new methods for Vistro/Visum)*

CAV Impacts -> Study CAVs in Vistro before
simulation

Vissim Integration Improvements
Export a Matrix from Trip Distributions to Vissim
Improved channelized radii and Vissim Export
Vissim select area (model are getting bigger)

Map search
Quickly find locations in the model

/

s

M»Better Channelized Turn Visuals and Expor’ﬁ

*Available after TRB publishes the new HCM update (early-January).



Trip Distribution Matrix:
Import to PTV Vissim

Benefits

Use your collected Origin-Destination in PTV Vistro
to build a Vissim model.

Use sources from INRIX, Streetlight Data ....
Large time savings in building a DTA model.

Use distribution instead of balanced background
counts. Useful on:

Innovative and alternative intersections/ interchanges
Corridors with tightly spaced intersections.
Saves time setting up Vissim static routing.

Note: Don't enter turn movement counts if using this method W Tk
to create a DTA model in Vissim. \ a5

Advénced Corridors.




File Edit View

Signal Control

Simulati

on Help a o

P S TWOTS,

Q Enter a search term...

Trip

S N A Wi N F

Intersection
Setup

Generation
Name
Zone

Zone

42 : Volumes

Land Use variables

Scenario:

Land Use Code

Base Scenario

Data Entry
Trips
Trips

Trips
Trips
Trips
Trips
Trips
Trips

n
n
iiga)

Trip
Distribution

Independent Variable

1§ - N )
Network
Optimization

Trip Generation Rate

Quantity

Intersection: | 3 Manning Dr at Ridge Rd

My Network,Internet.

aters Cre,

Meetingiof the W

§ . S - ;
Create zones in PTV Vistro, and
then enter the total number of
Trips In and Trips Out in the Trip
Generation workflow to set up the

matrix totals.

Comment

Trips Out

Trips Generated

1262
183

328

01
190

-8790194.1391 4282750.1592




File

Edit

View Signal Control ~ Simulation Help ‘ B Scenario: | Base Scenario

‘&,;.w‘ _ O - & -
3 - - G X ; C||58 y My Network, Internet...

2029 M axar;

In the Tr|p dlstrlbutlon window, enter your Zone-
 to-Zone trip shares as percentages. This could be
from your OD-data collection or estimates.

Note: PTV Vistro will round partially trips to a
whole trip.

softiorporation
£ Ot

Tbution Adrbus

From

1: Zone
2: Zone
4: Zone
5: Zone
6: Zone
7: Zone

8: Zone

Share
2.32%
0.87%
5.51%
53.26%
30.33%
4.78%
3.04%
100.14%

To Zone

Share
4.54%
0.00%
13.63%
25.75%
15.15%
3.03%
48.48%
110.60%

To Zone

Share
31.22%
1.35%
0.90%
37.55%
21.26%
3.61%
0.90%

for changes

Intersection:

From Zone

Share
0.50%
12.00%
14.90%
44.80%
18.10%
8.80%

0.90%
160.00%

From Zone

Share
13.70%
2.70%
3.40%
10.10%
4.10%
2.00%
64.10%
100.10%

From Zone

Share
33.91%
1.60%
8.50%
25.60%
10.30%
16.70%
3.40%

3 Manning Dr at Ridge Rd

Total Out trips from Zone 1: 573




File Edit View Signal Control Simulation Help « [ Scenario: | Base Scenario Intersection: | 3 Manning Dr at Ridge Rd -

‘\‘.r‘ —gite. =Y 2 3 =7 4 . —
.‘ T o 2| — : - -
\
#"' Q Enter a search term... ’ . )

ri" ~ : ‘- . ¥ Ve 3 a0y, i Trio ASS"’g? ment Add missing paths

Name Origin 4 | Origin Name |Destinati... | Destination ...| Volume Share |Volume [veh...| Length [ft] VMT

 Use PTVV|strosTr|p A55|gnment ‘ S YOG, o e 2 e oo 269

Automatically ... Zone 100.00% 155876

F Table to visualize zone pairs along /7 /f F="" \ " Sudum iR e woom e
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Zone 100.00% 163741
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2384.55
229275
1603.74
95469
1598.76
1515.82
138647
129468
605.66
7498.77
2547.56
2513.89
1515.82
113271
Zone 100.00% 1040.92
Zone 100.00% 3 155446
Zone 100.00% 244857
Zone 100.00% 241822
Zone 100.00% 238455
Zone 100.00% 138647 21.79
Zone 100.00% 113271
Zone 100.00% 911.58 7243
Zone 100.00% 742571 891
Zone 100.00% 231922 1625
Zone 100.00% 232642 92.09
Zone 100.00% 229275 434
Zone 100.00% 129468 11.52
Zone 100.00% 1040.52 2208 |~
-8789165.7042 4282408.2455
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File Edit View Signal Control Simulation Help ‘ * Scenario: |Base Scenario

E

e :__ ][9] Breemiee Select the type of PTV Vissim traffic signal controllers.

Open... = A

[} s _
B Save d ; - Anm Export (Vissim)

oY Anm Export (Vissim)

Print Report...

Sg nal Contro ®) With REC Controllers With Fixed Time Controllers
Import

Beport Vissim (ANM]... Cancel

1 C:\Users, Synchro...

2 C\Usersh, OTISS...

3 C\Usersh, SVG..
4 CahUsersh, Vistro (Current Scenario).

5 C:\Users\, Values..,
6 Ci\Usersh Merge Data...
Exit Update Data... m ANM import

In PTV Vistro, export the Vissim ANM. Static Network Data

Impert network data Ch\Users' Vistro Example Files\Currens

Delete omitted objects

Dynamic Traffic Data

(O Static Routing
(®) Dynamic assignment Evaluation interval:

Import routing |C:\Users‘ Vistro Example FiIes\Curren'|

Save as

EXpOrt PTV Vistro to P I \’ Vissi m Vissim Input File IC:\Users‘ Vistro Example FiIes\Curran'I
" 17} ANM network file Chapel Hill.panm
STEP for an “Out-of-the-box

. . . . ANM Routes File |Chapel Hill.panmRoutes |
simulation model with dynamic
assignment.

Complete routes after Import

Import Close Cancel

Open PTV Vissim and select File->Import ->
ANM and your .ANM and .ANMRoutes files.




Network Editor

| Verify the PTV Vissim network and
5% settings. Play your animation and
S\ b T A = collect your model's evaluation.

ST RS
- .aMM_
AR A . ac =z w8 :l

i I % { \ <
Bing Maps Terms of Usage [[lilfs . § ! 3 B R | A A Te=s “
Start Page Network Editor
Matrix Editor (Matrix '1: 200_.0900_1200")

a4 x
Short help

1 2 3 4 5 6 7 2
ANM zone 1 | ANM zone 2 | ANM zone 3 | ANM zone 4 | ANM zone 5 | ANM zone 6 | ANM zone 7 | ANM zone 8
Sum | 2070.00 | 219.00 642.00 | 651.00 | 1008.00 | 744.00 | 333.00 | 438,00
|ANM zone 1 | 1719.00 0.00 9.00 207.00 255.00 771.00 312.00 150.00 15.00 . . - . . . .
[ANMzone2 | 351,00 48.00 | 0.00] 9.00 | 12,00 36.00 15.00 | 6.00 | 20 «— Matrix now in Vissim. Customize your simulation start time,
ANM zone 3 57.00 18.00 0.00 0.00 6.00 15.00 6.00 9.00 3.00 . . .
|ANM zone 4 | 336.00 114.00 | 27.00 6.00 | 0.00 | 3.00 165.00 | 9,00 | 12.00 Intervalsl evaluatlons, and duratlons-
ANM zone 5 1845.00 1101.00 51.00 249.00 18.00 0.00 216.00 99.00 111.00
|ANM zone 6 | 1362.00 627.00 | 30.00 141,00 336.00 108.00 0.00] 57.00 | 63.00
|ANM zone 7 | 231.00 99.00 6.00 24.00 18.00 54.00 21.00 0.00 9.00
|ANM zone 8 | 204.00 63.00 96.00 6.00 | 6.00 21.00 9,00 | 3.00| 0.00

W~ U W N -

Matrices

B Z2X S BN EIBREAR &

Count:TlNo Name FromTime ToTime

S e +— Adjust the 3 hour start and end time window.
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Improved Channelization

Benefits:
Better visualization of channelized turns
Crosswalks now shown

More accurate Vissim ANM.

‘;'ff ey 3 r y £
Increased visualization




File

Edit

View

Signal Control

Simulation

Help

« =

Scenario:

Base Scenario

My Network,Internet.

Create a Vistro mod'el

with channelized turns.

Number
Intersection
Notes

Control Type
Analysis Method
Name

Show Name
Approach

Lane Configuration

Turning Movement

Base Volume Input [veh/h]

Total Analysis Volume [veh/h]
Intersection Settings

Priority Scheme

Analyze Intersection?

Analysis Period

Located in CBD

Controller ID

Signal Coordination Group

Cycle Length [s]

Coordination Type

Actuation Type

Offset [s]

Offset Reference

Permissive Mode

Lost time [s]

Pedestrian Walking Speed [ft/s]
Phasing & Timing

Control Type

Allow Lead/Lag Optimization

Signal Group

Auxiliary Signal Groups

Sequence
Ring 1
Ring 2
Ring 3

North Bend Rd

u]
Northbound

ak

Left Thru
50 150
50 150

Major

Intersection:
n
iii el
n
Automatic Optimization

23
New Intersection

Signalized
HCM 6th Edition
North Bend Rd \Westwood Northern Blvd
o u]
Southbound Eastbound

alr alle

Left Thru Right Left Thru Right
75 150 75 200 400 50
75 150 75 200 400 50

Minor

|
o

o
23

100
Time of Day Pattern Coordinated
Fixed time
0.0
Lead Green - Beginning of First Green
SingleBand
0.00
3.50

23 New Intersection

Westwood Northern Blvd
o

Westbound

Left Thru Right
100 400 100
100 400 100

Minor

ProtPerm Permissiv Permissiv | ProtPerm  Permissiv Permissiv | ProtPerm Permissiv Permissiv | ProtPerm  Permissiv Permissiv

u]
3

o o
2 8

o
4




Make modifications as needed in PTV
Vissim, such as this sidewalk extension.

‘'osoft Corporation o
21) Distribution Airbus DS

; : o ! % » . 2 ]
Jﬂrogoft productscreen shotreprinted with permission from Microsoft Corporation. ' a -~ \ ” > =N



Select intersections to export to PTV Vissim

Benefits:
Easy selection of intersections to export.

Supplement Vissim models with specific
Intersections.

Easy to add and test urban mobility elements in
PTV Vissim.

Take what you want to Vissim.

Use scenario management to save selection sets.



File

Edit

View  Signal Control

Simulation  Hel Scenario: | Base Scenario
p

/RN R

RS Q Enter a search term...

b

All intersection have an Analyze Intersection
checkbox. “Checked” boxes will be exported to

Number
Intersection
Notes

Control Type
Analysis Method
Name

Show Name

Turning Movement

Base Volume Input [veh/h]

Total Analysis Volume [veh/h]
Intersection Settings

Priority Scheme

Anzlyze Intersection?

Analysis Period

Located in CBD

Controller ID

Signal Coordination Group

Cycle Length [s]

Coordination Type

Actuation Type

Offset [s]

Offset Reference

Permissive Mode

Lost time [s]

Pedestrian WWalking Speed [f/s]
Phasing & Timing

Control Type

Allow Lead/Lag Optimization

Signal Group

Auxiliary Signal Groups

Sequence
Ring 1
Ring 2
Ring 3
Ring 4

Colorado

o
Northbound

Right
2
35

n
o

226

15th at Colorado

Signalized
HCM 6th Edition
Colorado
a
Southbound

Left
54
59

Intersection:

N
&

Automatic Optimization

15th

m]
Eastbound

ulllx

Thru Right
1460 65
1587 71

Major

226 15th at Colorado

15th

o

Westbound

allk

Thru Right
1218 0
1324 g

Major

15 minutes
o
226

2-15th St
135

Time of Day Pattern Coordinated

Fully actuated
93.0

Lead Green - Beginning of First Green

SingleBand
20.00
350

Permissive Permissive Permissive|Permissive Permissive Permissive| ProtPerm  Permissive Permissive| ProtPerm Permissive Permissive

o
4

o
8

of
2

o
6




_ 6: Filter Streets by 15t Street. Hold down
Analyze Intersection boxes can be shift to select multiple intersections.

“checked” or “unchecked” individually or

Name w Ylcontral Tuns sinnal Cont

modified in bulk with Edit->Multi -

° . 15th at Trinity 1kth
Change with a few clicks T
° 15th at San Antonio [5H =t Colorado
15th at Rio Grande 58 =t Congress
15th at Nueces {58 at Drive
15th at Lavaca H5ih =t E Red River
58 at Guadalupe
{58 =t IH 35 NBFR
i5HR at IH 35 SBFR
S8 ot Lavaca
iS58 at nueces

. 2: Select Analyze Intersection et orve B ot o Grande
Multi Change 15h ot Conres B 5o
15th at Colorado 58 =t san Jacnto
15th at Brazos 58 =t Trinity
Hi5Hi at W Red River
58 ot west

15th at IH 35 SBFR

15that IH 35 NBFR

15th at Guadalupe
Multi Change 15th at E Red River

Attributes Analyze Intersection

True
e . 3:Select False
Clear Filter
Intersections

d | Number Mame w |ConTrol Type Signal Control Coordination Group Multi Change

Two-way stop
1: Check all on .» F—— Multi Change
th Signalized

15th at West Signalized

15th at W Red River Signalized o e 8: Se|ect True

15th at Trinity Signalized Attribute Value

Attributes Analyze Intersection

False
15th at San Jacinto Signalized

=g ’
15th at San Antonio Signalized B 0 Intersections
15th at Rio Grande S|gna\|zed sted | Number Name -7 Control Type Signal Control Coordination Group

15th at Mueces Signalized

7: Check all on-(applies to 15 street only)

15th at Lavaca Signalized
15th at IH 35 SBFR Signalized
15th at IH 35 NBFR. Signalized 15th at San Antonio Signalized
15th at Guadalupe Signalized 15th at Rio Grande Signalized

15th at E Red River signalized 15th at Nueces Signalized
15th at Lavaca Signalized

15th at IH 35 SEFR. Signalized
15th at Congress Signalized 15th at IH 35 NEFR

15th at Drive Two-way stop
Signalized
15th at Colorade Signalized L5th at Guadalupe Signalized
15th at Brazos Signalized 15th at £ Red River Signalized
Lavaca at 13th Signalized Lsth at Drive Two-way stop
15th at Congress Signalized

15th at Colorado Signalized

e e, 5. V@ I’Ify message 4: Ap p |y Chan ges 15th at Brazos Signalized

e 101 Verify message  9: Apply Changes

Close




File Edit View Lists BaseData Traffic Signal Control Simulation Evaluation Presentation Test Actions Help
D D B i~ ; ﬂ (ad !ﬁ (&) @ v P> Pl B _ - Pauseat . = Network Editor
Network Objects Network Editor 2 x
Mn-\e-+,8 09 =0 % @ Short help
Desired Speed D... ﬁl- g RO 3 e fi o 3 e = 7 - : ; ; x %, § ]
Reduced Speed...

File ->E

Stop Signs
Signal Heads
Detectors
Vehicle Inputs
Vehicle Routes
Vehicle Attribute...
Parking Lots
Public Transport...
Public Transport...
Nodes
Data Collection..
Vehicle Travel Ti...
Queue Counters
Flow Bundles
Sections

T Background Ima...
Pavement Marki...
3D Traffic Signals
Static 3D Models

3D Information S...

M=

Vehicles In Netw...

Pedestrians In N...

Areas

Obstacles
Ramps & Stairs

Elevators

O e - -
= = =

w
5

Levels Backg...
Quick View

2028 Maxa g
© 2073 m.%.;ll.nu Corporat
BENES (2071 Distrbution it




Enjoy your “out-of-the-box” simulation!




Map Search

Benefits:
Quickly find intersections or corridors
Find a city fast
Find higher-level POls.

e m { ! 8 y

PTV Vistro takgyou to where you want to go.
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HCM 7th Edition Overview (related to Vistro)

HCM 7th Edition will be released by TRB during the TRB Annual Meeting*

Key Updates related to Vistro:

« CAV modeling
Signals
Roundabouts

« TWSC updates

 Errata

Lots of other updates to other methods as well

*Note: TRB is planning to release the E-pub version of the HCM 7t Edition during the TRB Annual
Meeting in January 2022. The print edition is estimated to be released a couple of months afterwards.

cli{ellid  www.ptvgroup.com



Future HCM 7t Edition Highlights

CAV analysis

Penetration rates, adjusted saturation flow rates and
adjustment factors:

= Signalized Intersections

= Roundabouts

Two-way stop control

= Flared Lane updates

Cormected and Autonomous

Test CAVs deterministically. Utilize
scenario management and network
optimize based on market penetration
rates!

= Minor Lefts one-stage movement updates

= Shared Major-Street lane sharing updates

www.ptvgroup.com



CAV Analysis — Signalized Intersections

Signalized Method

CAV adjustment values were derived from microsimulation using assumptions based
on current knowledge; CAV adjustment values were not field validated due to the
current lack of CAV market penetration in the field.

Refer to FHWA Pooled Fund Study TPF- 5(371) “Developing Highway Capacity Manual
Capacity Adjustments for Connected and Autonomous Vehicles under Varying Levels of
Volume and Market Penetration” led by Kittelson & Associates and ODOT.

Note:

The HCM methodology for CAV analysis assumes that the CAV market penetration rate
is a global input for the entire intersection. These planning-level adjustment factors
currently do not support varying the percentage of CAVs on a per-lane or per-approach basis.

cli{ellid  www.ptvgroup.com



CAV Analysis — Signalized Intersections

Signalized Method

Refresher - Saturation flow adjustment calculation:

S =35 fw fHVg fp fbb fa fLU fLT fRT prb prb fwz fms fsp

Where:
s = adjusted saturation flow rate (veh/h/In),

s, = base saturation flow rate (pc/h/In),

f, = various adjustment factors (lane width, heavy vehicles and grade, parking, bus blocking, area
type, lane utilization, left-turn vehicle presence, right-turn vehicle presence, ped-bike adjustment

for left-turn, ped-bike adjustment for right-turn, work zone, downstream lane blockage, sustained
spillback)

cli{ellid  www.ptvgroup.com



CAV Analysis — Signalized Intersections

Signalized Method

Base saturation flow (s,) adjustments:

Proportion of CAVs Base Saturation Flow Rate
in Traffic Stream (pc/h/In)

0 1,900

20 2,000

40 2,150

60 2,250

80 2,550
100 2,900

Notes: CAV = connected and automated vehicle, defined here as a vehicle with an operating cooperative adaptive

cruise control system.

Assumes no interaction with non-motorized road users, no adverse weather impacts, and a facility without
driveways or access points impacting saturation flow rates.

Interpolate for other CAV proportions.

Exhibit 31-64

Base Saturation Flow Rates
for CAVs for Through
Movements at Signalized
Intersections

Additionally, the lane-width adjustment factor (f,, ) should not be applied (1.0) when CAVs are present.

cli{ellid  www.ptvgroup.com



CAV Analysis — Signalized Intersections

Signalized Method

Protected Left Turns adjustments (f4y, ) :

Proportion of CAVs Saturation Flow Rate Adjustment for
in Traffic Stream Protected Left Turns, fcavpror

0 1.00

20 1.01

40 1.07

60 1.11

80 1.21
100 1.56

Notes: CAV = connected and automated vehicle, defined here as a vehicle with an operating cooperative adaptive
cruise control system.

Assumptions: Average intervehicle gap within CAV platoons = 0.71 s, CAV interplatoon gap = 1.5 s,
maximum CAV platoon size = 8 pc, human-driven vehicles operate with through movement saturation
flow rates calibrated to 1,900, assumes no interaction with non-motorized road users, no adverse
weather impacts, and a facility without driveways or access points impacting saturation flow rates.

Interpolate for other CAV proportions.

Exhibit 31-65

Saturation Flow Rate

CAV Adjustment for Protected Left
Turns at Signalized Intersections

Additionally, these factors should not be used in addition to the values in Exhibit 31-64 (the s, adjustments).

cli{ellid  www.ptvgroup.com



CAV Analysis — Signalized Intersections

Signalized Method

Permitted Left Turns adjustments (fc4y, /)

EXhibiF 31-66 Proportion of Saturation Flow Rate Adjustment for Permitted Left Turns fcavperm
Saturation Flow Rate CAV CAVs in Traffic by Opposing Through Volume Per Lane (pc/h/In)
Adjustments for Permitted Stream 300 450 600 750
Left Turns at Signalized 0 1.00 1.00 1.00 1.00
Intersections 20 1.12 1.04 1.03 1.07

40 1.20 1.16 1.12 1.18

60 1.29 1.22 1.26 1.36

80 1.43 1.43 1.57 1.60

100 1.76 1.72 1.66 1.90

Notes: CAV = connected and automated vehicle, defined here as a vehicle with an operating cooperative adaptive
cruise control system.

Assumptions: Average intervehicle gap within CAV platoons = 0.71 s, CAV interplatoon gap = 1.5 s,
maximum CAV platoon size = 8 pc, human-driven vehicles operate with through movement saturation
flow rates calibrated to 1,900, assumes no interaction with non-motorized road users, no adverse
weather impacts, and a facility without driveways or access points impacting saturation flow rates.

Interpolate for other CAV proportions.

Additionally, these factors should not be used in addition to the values in Exhibit 31-64 (the s, adjustments).

cli{ellid  www.ptvgroup.com



CAV Analysis — Roundabouts

Roundabout Method

CAV adjustment values were derived from microsimulation using assumptions based
on current knowledge; CAV adjustment values were not field validated due to the
current lack of CAV market penetration in the field.

Refer to FHWA Pooled Fund Study TPF- 5(371) “Developing Highway Capacity Manual
Capacity Adjustments for Connected and Autonomous Vehicles under Varying Levels of
Volume and Market Penetration” led by Kittelson & Associates and ODOT.

Note:

The HCM methodology for CAV analysis assumes that the CAV market penetration rate
is a global input for the entire intersection. These planning-level adjustment factors
currently do not support varying the percentage of CAVs on a per-lane or per-approach basis.

cli{ellid  www.ptvgroup.com



CAV Analysis — Roundabouts

Roundabouts Method

Capacity Adjustment Factors

Copce = Ae " BVepce Equation 33-1
— —fgBv Equation 33-2
Ce,adj,pce — fAAe cpce 9
where
Copee = €ntry lane capacity, adjusted for heavy vehicles (pc/h); ¢ . = entry lane capacity, adjusted for CAVs and heavy vehicles (pc/h);
A = intercept parameter, f Exhibit 33-12; . . -y
FCTCEPT PATATETEL, Jrom Bl fa = adjustment factor for the intercept parameter, from Exhibit 33-13; and
B = slope parameter, from Exhibit 33-12;
0, = contlicting flow rate (pc/h); fz = adjustment factor for the intercept parameter, from Exhibit 33-13.
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CAV Analysis — Roundabouts

Roundabouts Method

To determine the CAV-adjusted capacity, first identify the values of A and B from Exhibit 33-12 for the
appropriate combination of number of entry lanes and number of conflicting circulating lanes.

Entry Lane Type A B

One-lane entry conflicted by one circulating lane 1,380 1.02x10°
Two-lane entry conflicted by one circulating lane (both entry lanes) 1,420 0.91x10°3
One-lane entry conflicted by two circulating lanes 1,420 0.85x10°
Two-lane entry conflicting by two circulating lanes (right entry lane) 1,420 0.85x1073
Two-lane entry conflicting by two circulating lanes (left entry lane) 1,350 0.92x10°3

Source: Equations 22-1 through 22-5.
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Exhibit 33-12
Roundabout Entry Lane
Capacity Model Parameters
(without CAVs)



CAV Analysis — Roundabouts
Roundabouts Method

Next, identify the values of f, and f; from Exhibit 33-13 for the combination of subject entry lane type and
proportion of CAVs in the traffic stream.

1-Lane Entry 2-Lane Entry Exhibit 33-13
1 Circulating | 2 Circulating | 2 Circulating Capacity Adjustment Factors
Proportion of | 1 Circulating | 2 Circulating Lane, Lanes, Lanes, for CAVs for Roundabouts
CAVs in Lane Lanes? Both Lanes? | LeftLane Right Lane
Traffic Stream y 7 I y7 I 71 Is I I f I
0 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00
20 1.05 0.99 1.03 0.99 1.05 0.99 1.03 0.99 1.05 0.96
40 1.12 0.97 1.08 0.96 1.12 0.97 1.08 0.96 1.12 0.93
60 1.22 0.94 1.18 0.92 1.22 0.94 1.18 0.92 1.20 0.87
80 1.29 0.90 1.28 0.89 1.29 0.90 1.28 0.89 1.27 0.84
100 1.35 0.85 1.38 0.85 1.35 0.85 1.38 0.85 1.34 0.80
Notes: 2 These cases were not specifically analyzed in the research and thus are suggested approximations.
CAV = connected and automated vehicle, defined here as a vehicle with an operating cooperative adaptive
cruise control system.
Interpolate for other CAV proportions.
Assumptions: Human-driven vehicles operate with average gaps calibrated to the entry lane capacity given
by Chapter 22.
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CAV Analysis — Roundabouts
Roundabouts Method

Finally, apply these values in Equation 33-2 to determine the subject entry lane’s adjusted capacity.

Copce = Ae " BVcpce Equation 33-1
— —fgBv Equation 33-2
Ce,adj,pce — fAAe epee 9
where
Copee = €ntry lane capacity, adjusted for heavy vehicles (pc/h); ¢ = entry lane capacity, adjusted for CAVs and heavy vehicles (pc/h);
A = intercept parameter, f Exhibit 33-12; . . -y
FCTCEPT PATATETEL, Jrom Bl fa = adjustment factor for the intercept parameter, from Exhibit 33-13; and
B = slope parameter, from Exhibit 33-12;
0, = contlicting flow rate (pc/h); fz = adjustment factor for the intercept parameter, from Exhibit 33-13.
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Two-Way Stop Control Updates

TWSC Method Updates

Updated calculation of Rank 4 capacity (Step 9a, Section 20-3)
Rank 4 = |eft-turns from minor street at 4-leg intersection

Updated to correct an overestimation of capacity for minor-street left-turn movements for one-stage
movements.

Updated calculation of flared minor-street lane effects (Step 10b, Section 20-3)
Updated to simplify and improve the accuracy of the calculations.

Adjusted calculation of shared major-street lane effects (Step 7d, Section 20-3). "

cli{ellid  www.ptvgroup.com


Presenter
Presentation Notes
Why not Step 3 Updates? Why not new Step 10c?




